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Notations Used in This Guide

Safety Symbols
The projector and its manuals use graphical symbols and labels to indicate content that tells you how to use the product safely.
Read and carefully follow the instructions that are marked with these symbols and labels to avoid injury to persons or damage to property.

Warning
This symbol indicates information that, if ignored, could possibly result in personal injury or even death.

Caution
This symbol indicates information that, if ignored, could possibly result in personal injury or physical damage due to incorrect handling.

General Information Notations

Attention
This label indicates procedures that may result in damage or injury if sufficient care is not taken.

This label indicates additional information that may be useful to know.

[Button name] Indicates the name of the buttons on the remote control or the control panel.
Example: [Esc] button

Menu/Setting name Indicates projector menu and setting names.
Example:
Select the Image menu
s Image > Advanced

This label indicates links to the related pages.

s This label indicates the projector's current menu level.

g Related Links
• "Using the Manual to Search for Information" p.5



The PDF manual allows you to search for information you are looking for by
keyword, or jump directly to specific sections using the bookmarks. You can
also print only the pages you need. This section explains how to use a PDF
manual that has been opened in Adobe Reader X on your computer.

g Related Links
• "Searching by Keyword" p.5
• "Jumping Directly from Bookmarks" p.5
• "Printing Only the Pages You Need" p.5

Searching by Keyword

Click Edit > Advanced Search. Enter the keyword (text) for information you
want to find in the search window, and then click Search. Hits are displayed as a
list. Click one of the displayed hits to jump to that page.

Jumping Directly from Bookmarks

Click a title to jump to that page. Click + or > to view the lower level titles in
that section. To return to the previous page, perform the following operation on
your keyboard.
• Windows: Hold down Alt, and then press ←.

• Mac OS: Hold down the command key, and then press ←.

Printing Only the Pages You Need

You can extract and print only the pages you need. Click Print in the File menu,
and then specify the pages you want to print in Pages in Pages to Print.
• To specify a series of pages, enter a hyphen between the start page and the

end page.
Example: 20-25

• To specify pages that are not in series, divide the pages with commas.
Example: 5, 10, 15

Using the Manual to Search for Information 5



Introduction to the Easy Interactive Tools Software

See the information here to learn more about the Easy Interactive Tools software.

g Related Links
• "Easy Interactive Tools Features" p.7



The Easy Interactive Tools software is an application that allows you to draw on
projected images. By using your finger (on projectors that support finger touch
operation) or the interactive pen supplied with a projector, or your computer
mouse, a variety of interactive functions become available.

g Related Links
• "Drawing on a Plain Background (Whiteboard Mode)" p.7
• "Drawing on the Projected Image (Annotation Mode)" p.7
• "Other Interactive Functions" p.7
• "Converting Old Whiteboard Drawing Data (Epson EWF Converter)" p.8

Drawing on a Plain Background (Whiteboard Mode)

Whiteboard mode allows you to add text or images to a solid color background.
You can also select different backgrounds such as grid lines or a music sheet.
Lined backgrounds could be useful for writing minutes or notes during a
meeting.

g Related Links
• "Tool Panel Functions" p.32
• "Drawing in Whiteboard Mode" p.18
• "Adjusting and Editing Shapes and Images" p.20

Drawing on the Projected Image (Annotation Mode)

Annotation mode allows you to add notes to the projected image. By using
illustrations, images, and graphics, you can enhance classroom lessons and
create more appealing presentations.

g Related Links
• "Drawing in Annotation Mode" p.20

Other Interactive Functions

You can also perform the following operations with the Easy Interactive Tools
software:
• Operate the computer's mouse
• Control a Epson document camera connected to a computer
• Edit content drawn on the projected screen
• Save the content you created
• Network teleconferencing

Easy Interactive Tools Features 7



When you connect a projector to a computer over a network using the
Epson iProjection software, you can share the projected screen with a remote
location.
When used with the Easy Interactive Tools software, you can share
annotations and drawings made on the projected screen with multiple
locations.
For more information about the Epson iProjection software, visit the Epson
Web site.

g Related Links
• "Tool Panel Functions" p.32
• "Operating a Mouse from the Projected Image (Mouse Operations)" p.23
• "Using the Software with a Document Camera" p.26
• "Adjusting and Editing Shapes and Images" p.20

Converting Old Whiteboard Drawing Data (Epson EWF
Converter)

When you install Easy Interactive Tools on your computer, Epson EWF
Converter is also installed. Epson EWF Converter can convert .ewf files
into .ewf2 format without starting Easy Interactive Tools. This feature allows
you to read whiteboard drawing data created on old projectors with your new
projectors.

g Related Links
• "Converting .ewf Files into .ewf2 Format" p.29
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Setting Up the Software for the First Time

Check the system requirements necessary to run the Easy Interactive Tools software, and then install the software.

g Related Links
• "Easy Interactive Tools System Requirements" p.10
• "Installing the Software" p.11



Your computer must meet the following system requirements to use the Easy
Interactive Tools software.

Easy Interactive Tools System Requirements 10

Requirement Windows Mac

Operating system Windows 10
• Windows 10 Home (32- and 64-bit)

• Windows 10 Pro (32- and 64-bit)

• Windows 10 Enterprise (32- and 64-bit)

• Windows 10 Education (32- and 64-bit)

macOS

• macOS 13 (Ventura)

• macOS 14 (Sonoma)

• macOS 15 (Sequoia)

• macOS 26 (Tahoe)

Windows 11

• Windows 11 Home (64-bit)

• Windows 11 Pro (64-bit)

• Windows 11 Enterprise (64-bit)

• Windows 11 Education (64-bit)

CPU Intel Core2 Duo 1.2 GHz or faster
(Intel Core i3 or faster recommended)

• Intel Core2 Duo 1.2 GHz
or faster
(Intel Core i5 or faster
recommended)

• Apple M1 or later
(Apple Silicon)

Memory 4 GB or more
(8 GB or more recommended)

Hard disk space 10 GB or more
(20 GB or more recommended)

Display Resolution between 1024 × 768 (XGA) and 1920 × 1200 (WUXGA)
16-bit color or greater



Install the Easy Interactive Tools software by downloading it from the Epson
Web site.

If the language selected for the installation differs from the language of the
operating system being used, the screens may not display correctly.

g Related Links
• "Installing the Easy Interactive Tools Software (Windows)" p.11
• "Installing the Easy Interactive Tools Software (Mac)" p.11

Installing the Easy Interactive Tools Software
(Windows)

Install the Easy Interactive Tools software on your computer.

You need administrator rights to install the software.

a Turn on your computer.

b Make sure all running applications are closed.

c Download the software from the Epson Web site.

d Follow the on-screen instructions to install.

e When you see the license agreement, accept the terms and click Next.

f Click Install.

Installing the Easy Interactive Tools Software (Mac)

Install the Easy Interactive Tools software on your computer.

a Turn on your computer.

b Make sure all running applications are closed.

c Download the software from the Epson Web site.

d Follow the on-screen instructions to install.

e When you see the license agreement, accept the terms, click Continue,
and then click Agree.

f Click Install.

For interactive projectors, you need to install the Easy Interactive
Driver for Mac. Visit the Epson Web site to download the Easy
Interactive Driver for your projector model.

Installing the Software 11



Using the Easy Interactive Tools Software

Follow the instructions in these sections to use the Easy Interactive Tools software.

g Related Links
• "Preparing to Use the Software with Your Projector" p.13
• "Starting the Easy Interactive Tools Software" p.14
• "Operating the Interactive Pen" p.15
• "Finger Touch Operations" p.16
• "Drawing Screens and Modes" p.17
• "Saving the Screens to a File" p.24
• "Using the Software with a Document Camera" p.26
• "Using the Slideshow Drawing Tools" p.27
• "Exiting the Easy Interactive Tools Software" p.28
• "Converting .ewf Files into .ewf2 Format" p.29



Make the following preparations to use the Easy Interactive Tools software with
your projector.

• Some projector models require a USB cable for interactivity. For details,
see the projector User's Guide.

• If you see a message prompting you to allow access to other
applications on a Mac, select OK.

When connecting a computer to the projector with a USB cable:
• Connect the USB cable to the computer's USB port and the projector's USB-B

port.
• Set up the interactive pen or finger touch feature using the projector's menu

system. For details, see the projector User's Guide.

When connecting a computer to a projector over a network:
• Configure the network settings so that the computer can connect to the

network.
• Connect a wireless LAN module (if necessary) or a LAN cable so that the

projector can connect to the network.
• Select the network settings from the projector's menu system.
• Install the Epson iProjection software on your computer.
• In the Epson iProjection software, open the Set options screen, select the

General settings tab, and select Use Easy Interactive Tools.

Preparing to Use the Software with Your Projector 13



You can start the Easy Interactive Tools software with these steps.

a Turn on the projector and project images from the computer.

b Start the Easy Interactive Tools software on the computer.

• Windows 10/11: Click  > Easy Interactive Tools Ver.X.XX.
• Mac: From the Applications folder, double-click Easy Interactive Tools

Ver.X.XX.
The Easy Interactive Tools software starts.

The screen for selecting the launch mode is displayed the first
time you launch the software. You can select annotation mode or
whiteboard mode.

• If you start the Easy Interactive Tools software while playing a movie,
the movie playback screen may turn black. Restart the application that
is playing the movie.

• Before you begin drawing on the projected image using this software,
save any drawings drawn with the projector's interactive feature and
clear the screen.

• You can select which mode is displayed immediately after launching
the software on the General tab on the Settings screen.

g Related Links
• "General Tab" p.35
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You can use the interactive pen supplied with your projector to operate the Easy
Interactive Tools software. The functions and shape of the interactive pen differ
depending on the projector model it came with. For details, see your projector
User's Guide.

a Check that there is a battery in the interactive pen and then turn it on.

b Press the pen tip button to the screen to select an icon.

c Press and move the pen on the screen to draw.

• You can use two interactive pens at the same time, if available for your
projector model. However, you can only use one while connected to
a network or while on a window displayed in Whiteboard mode. See
your projector User's Guide for more information.

• You can operate the Easy Interactive Tools software with up to six
devices at the same time (up to three devices with Mac), such as a
mouse connected to a computer, interactive pens, and finger touch,
depending on your projector model.

• The following operations can only be performed by one device:
• Operations on the Settings screen, Camera screen, Insert image

screen, Select background screen, Open file screen, Save file screen,
Export screen, and Print screen

• Adjusting and editing identical shapes and images
• Entering text
• Operations on a window displayed in Whiteboard mode

Caution
Do not hold the tip of the interactive pen or allow it to become cracked or dirty.
Otherwise, the interactive pen may fail to operate.

Operating the Interactive Pen 15



On projectors that support finger touch operation, you can use your finger to
perform the same functions as the interactive pen.
When performing finger touch operations, you can use two fingers for multi-
touch operations such as enlarging or reducing the image. The projector
recognizes up to six multi-touch points. When a group of people are performing
finger touch operations, all members must use the same drawing tool.

Finger Touch Operations 16



The Easy Interactive Tools software provides two drawing modes. When you
change the mode, the screen changes as shown below.

Whiteboard Mode
Allows you to display and draw on a plain screen. You can treat the drawing
area as a page and create multiple pages to draw on. You can also save your
drawings as a file (using .eit or .iwb file format) and open them again later.

Annotation Mode
Allows you to draw on the image currently displayed on the computer. This is
useful when you need to emphasize certain points or add notes. You can also
draw on images from a document camera.

Mouse Operations
Allows you to operate the computer from the projected image. You can use the
interactive pen to perform operations such as click, right-click, and drag and
drop.

In the Easy Interactive Tools software, you can select a drawing screen according
to the environment in which you are using the projector. To enable annotating

on a secondary display or extended desktop, click  >  on the toolbar, and
then select settings on the Enlarge Screen tab.

Drawing Screens and Modes 17



Primary Display
You can project your computer's screen to draw on the projected screen.

Secondary Display (Extended Desktop)
While displaying content on your computer screen, you can project different
content from the projector. You can draw only on the projected screen.

You must first configure your computer display settings for Secondary
Display (Extended Desktop). See your computer documentation for more
information.

Use Multi-Projection
You can project images from multiple projectors and draw across two of the
projected screens.

g Related Links
• "Drawing in Whiteboard Mode" p.18
• "Drawing in Annotation Mode" p.20
• "Adjusting and Editing Shapes and Images" p.20
• "Enlarging an Area" p.22
• "Shading an Area" p.22
• "Turning a Spotlight on an Area" p.22
• "Drawing Across Two Screens" p.23
• "Operating a Mouse from the Projected Image (Mouse Operations)" p.23

Drawing in Whiteboard Mode

You can draw on a plain page in Whiteboard mode. You can add pages and
display a page list screen where you can perform additional page operations.
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a Make sure that  is displayed on the toolbar. If  or  is displayed,

click it and select .

Whiteboard mode starts and a new page is displayed.

To open a previously saved file, select  >  from the toolbar.

b Select  to select pen type, thickness, or shape.

c Select the color of the pen or the shape you are using on the toolbar.

d Draw on the page.

e To erase drawings, select one of the following tools from the toolbar:

•  allows you to use the interactive pen or your finger (if supported) as
an eraser.

•  erases all of the current drawings.

f Click  to display the page list screen where you can add, delete,
duplicate, or move pages.

• To add and display a new page, click .

• To duplicate the currently displayed page, click .

• To delete the currently displayed page, click .
• To change the displayed page in the page list screen, select a thumbnail

image.
• To change the display order, drag and drop a thumbnail image.

• To insert the image, click .

• To select the background, click .

g Related Links
• "Changing Between Full Display and Window Display" p.19
• "Saving the Screens to a File" p.24

Changing Between Full Display and Window Display

When you select  or  in Whiteboard mode, you can switch the
drawing screen between full display and window display.
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During window display, you can use only one finger (if supported) or
one interactive pen, and operations outside the window become computer
mouse operations.

Drawing in Annotation Mode

You can draw on images projected from a computer's screen or document
camera in Annotation mode.

a Select  >  from the toolbar.

Annotation mode starts and the computer's screen is displayed.

b Select  to select pen type, thickness, or shape.

c Select the color of the pen or the shape you are using on the toolbar.

d Draw on the projected image.

e To erase drawings, select one of the following tools from the toolbar:

•  allows you to use the interactive pen or your finger (if supported) as
an eraser.

•  erases all of the current drawings.

g Related Links
• "Camera Screen" p.33
• "Saving the Screens to a File" p.24

Adjusting and Editing Shapes and Images

You can adjust and edit shapes, lines, and images you have inserted into your
drawings using the tools on the toolbar.

When selecting objects drawn with lines, be sure to select the solid line.

• To enlarge or reduce an object, select , select the object, and drag the
points shown here to change the size.
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When using finger touch (if available), select two points on the object.
To enlarge it, move your fingers apart. To reduce it, move your fingers
closer together.

• To rotate an object, select , select the object, and rotate it using the
rotation point shown here.

When using finger touch (if available), select two points on the object
and move your fingers in the direction you want to rotate the object.

• To perform any other available toolbar options on your object, select ,

select the object, and select  to open the submenu of options.

g Related Links
• "Toolbar Submenu Options" p.21

Toolbar Submenu Options

You can select options for performing additional operations on the toolbar
submenu.

You can select multiple objects and perform operations on them
simultaneously by dragging the mouse over the objects.

Option Description

Line Thickness Selects the line thickness of the selected object.

Duplicate Creates a duplicate of the currently selected object and
places it at the lower right of that object.

Infinite Cloning Enters Infinite Cloning mode, allowing you to copy selected
objects by dragging and dropping them. You can also select

at the top right of the object frame. The icon changes to

 to indicate that you are in Infinite Cloning mode.

Cancel Infinite Cloning Cancels Infinite Cloning mode for the selected object. You

can also select  at the top right of the object frame.

The icon changes to  to indicate that you have cancelled
Infinite Cloning mode.

Copy Copies the selected object to the clipboard. You can select
multiple objects to copy at one time. (The Ctrl + c keyboard
shortcut is not available in the Easy Interactive Tools
software.)
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Option Description

Paste Pastes an object from the clipboard into your drawing. (The
Ctrl + v keyboard shortcut is not available in the Easy
Interactive Tools software.)

Edit Allows you to edit the selected text.

Group Groups multiple selected objects together to create one
object.

Ungroup Removes the grouping of previously grouped objects.

Bring to Front Changes the overlapping order for the selected object in
relation to other objects.

Send to Back

Bring Forward

Send Backward

Delete Deletes the selected object.

Enlarging an Area

You can zoom into a portion of the image and enlarge it on the screen.

a Select  >  from the toolbar.
You see a crosshair on the screen.

b Drag the mouse over the area you want to zoom into.
You see the Enlarge Area screen.

c To close the Enlarge Area screen, select  in the upper right corner.

Shading an Area

You can hide a portion of image or the entire projected screen by covering it
with a black screen.

a Select  >  from the toolbar.
You see the shading screen over the projected screen.

b Adjust the size of the shading screen by dragging the edge of the screen.

c Adjust the position of the shading screen by dragging anywhere in the
black area.

d To close the shading screen, select  in the upper right corner.

Turning a Spotlight on an Area

You can display a portion of projected screen and hide the rest of the screen.

a Select  >  from the toolbar.
You see the spotlight screen.

b Adjust the size of the spotlight area by dragging the edge of the spotlight
area.

c Adjust the position of the spotlight area by dragging anywhere in the black
area.

d To close the spotlight screen, select  in the upper right corner.
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Drawing Across Two Screens

You can draw across two screens when multiple projectors are connected to a
computer.

You need to install Easy Interactive Driver Ver.4.0 to draw across two
screens. The multi-screen functions vary depending on the projector
model. For details, see your projector User's Guide.

Before drawing across two screens, do the following:
• Connect an image signal cable such as a computer cable or an HDMI cable to

your computer and the projectors.
• Connect the USB cable to the computer's USB port and the projector's USB-B

port.
• Setup the projector so that you can use the interactive features with a unified

image area created by multiple projectors. For details, see your projector
User's Guide.

Check the following on your computer:
• The resolution for the primary display and the secondary display are the

same.

• The primary display and the secondary display are displayed at the same
height.

• The secondary display is placed on the right of the primary display.
• Make sure System Configuration > Mission Control > Operating space for

each display is set to Off (Mac only).

a In the Easy Interactive Tools software, click  >  on the toolbar.
You see the Settings screen.

b On the Enlarge Screen tab, select Use Multi-Projection under Use Screen
Settings.

Operating a Mouse from the Projected Image (Mouse
Operations)

When you select  >  from the toolbar, you can operate the computer from
the projected image (mouse operations). When mouse operations are activated,
you can use the interactive pen to perform operations such as click, right-click,
and drag and drop.
• To click, press and remove the pen tip from the projected image.
• To right-click, press the button on the interactive pen, or hold the pen tip on

the projected image for a few seconds and then remove it.
• To drag and drop, press the pen tip to the icon or object that you want to

move, drag the pen tip to where you want to move the object, and then
remove the pen tip from the projected image.
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You can save the contents of your screens and drawings to a file.

a Select  from the toolbar. If  is not displayed on the toolbar, click .

b Select the save location, file name, and the file format.
You can save all pages with drawings in .jpg, .bmp, .png, .pdf, .eit or .iwb
format. If you want to edit a file again in the future, you must save it in .eit
or .iwb format.

• Saving in .jpg, .bmp, or .png format saves all pages by treating
one page as one file. Saving in .pdf, .eit or .iwb format saves all
pages in one file.

• You can select the save location, file name, and the file format on
the Save tab on the Settings screen.

g Related Links
• "Supported File Types" p.24

Supported File Types

You can use these file types with the Easy Interactive Tools software.
.eit

Dedicated file types for the Easy Interactive Tools software.
.iwb

File types for Interactive Whiteboard mode.
.ewf/.ewf2

File types for Whiteboard mode of Epson projectors.
.avi (for Windows)/.mov (for Mac)

Video file types for each operating system.
.pdf

Document file types.

.jpg/.bmp/.png
Image file types.

See the following table to confirm the supported input/output format for this
software.

File types Input Output

.eit Supported Supported

.iwb Supported Supported

.ewf Supported Not Supported

.ewf2 Supported Supported

.avi Supported Not Supported

.mov Supported Not Supported

.pdf Not Supported Supported

.jpg/.bmp/.png Not Supported Supported
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• When you open an .ewf/ewf2 format file in the Easy Interactive Tools
software, colors or lines may be displayed differently than the original.

• Polygons, GIF Animations, and some media objects, such as movies
or audio embedded in .iwb format, are not supported in the Easy
Interactive Tools software. Note the following limitations.
• Polygons are converted to still image objects.
• GIF animations are not displayed and only the first image of an

animation is displayed.
• Media objects such as .wmf, .emf, .mpeg, .swf, .wav, and .mp3 files

are displayed as the unsupported objects.
• Colors or lines may be displayed differently than the original.
• Dotted lines or dashed lines are displayed as solid lines.
• When you open an .iwb file and save the content of your drawings

to an .eit file in the Easy Interactive Tools software, the unsupported
objects will be lost. Select the .iwb file type if you want to restore
these objects.

• If you open an .eit, .iwb, .ewf or .ewf2 file on another computer with
a different display resolution, some parts of the drawing may not be
displayed or the black band may be displayed.

• Note the following limitations when saving drawings in .ewf2 format.
• The background is displayed as white.
• Music, movies, and text data is not converted.
• Some parts of the drawing may not be displayed depending on the

file size.
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You can draw on images projected from a document camera.

Connect the computer to your projector with an HDMI or VGA cable
when using a document camera.

a Click the  >  on the toolbar.

b Select the document camera from which you want to project from the
displayed list.
You see the image projected from the document camera on the Camera
screen.

c Draw on the images projected from the document camera.

d If you want to paste the currently displayed document camera image onto

a page in Whiteboard mode, select  from the toolbar.

e Select  from the toolbar to save the screen to a file.

g Related Links
• "Camera Screen" p.33
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When you project a PowerPoint slideshow, the toolbar changes so you can use
PowerPoint drawing tools.
The following PowerPoint versions are supported:
• Windows: Microsoft PowerPoint 2010/2013/2016/Office 365
• Mac: Microsoft PowerPoint 2016/Office 365

You can choose whether or not to use the PowerPoint drawing tools and
select options for them on the General tab on the Settings screen.

a Start the Easy Interactive Tools software, then start a PowerPoint
slideshow.
The toolbar changes to the PowerPoint drawing toolbar.

b Use the tools to draw on your PowerPoint slideshow as necessary.

c With Windows, you can save your PowerPoint slideshow with the drawing
content. (With Mac, you can only draw.)

g Related Links
• "PowerPoint Drawing Toolbar Functions" p.27
• "General Tab" p.35

PowerPoint Drawing Toolbar Functions

You can perform the following functions on the PowerPoint drawing toolbar.

A  Back
Goes back to the previous page in the slideshow.

B  Next
Goes to the next page in the slideshow.

C  Arrow
Switches the pen to the cursor.

D  Pen
Switches the cursor to the pen.

E  Color
Selects the color of the pen.

F  Eraser (Windows)/Clear screen (Mac)
Switches to an eraser or clears all drawing from the displayed page.

G

Switches the PowerPoint drawing toolbar to Simple or Full view.

H  End Show
Exits the slideshow.
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You can exit the Easy Interactive Tools software using one of the following
methods:

• Click  on the toolbar.

• Windows: Right-click  on the task tray and click Exit.

• Mac: Control-click  in the Dock, go to the Easy Interactive Tools software,
and select Quit Easy Interactive Tools.
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Epson EWF Converter can convert .ewf files into .ewf2 format without starting
Easy Interactive Tools. This feature allows you to read whiteboard drawing data
created on old projectors with your new projectors.

a Start the Epson EWF Converter software on the computer.

• Windows 10/11 : Click  > Epson EWF Converter .
• Mac : From the Applications folder, double-click Epson EWF

Converter .
The Epson EWF Converter software starts.

b Follow the on-screen instructions to select the .ewf file and perform
conversion.

When you convert .ewf files into .ewf2 format, the background is
displayed as white.
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Screen Summary

See these sections for more information about the Easy Interactive Tools screens.

g Related Links
• "Toolbar Functions" p.31
• "Whiteboard Tools Functions" p.43



You can perform the following functions on the toolbar.
Whiteboard mode/Annotation mode

Mouse mode

• The display format of the toolbar is optimized for the mode and
window size you are using.

• You can also use the mini toolbox by right-clicking anywhere in the
drawing area. You can switch the type of pen or eraser on the mini
toolbox.

A  Whiteboard mode/Annotation mode/Mouse
Select to switch to each mode.

B  Save
Saves the displayed screen. You can open the saved file in Whiteboard mode. If
you save in .pdf, .eit or .iwb format, all pages are saved as one file.

If  is not displayed on the toolbar, click .

C  Capture
Captures the current screen and copies it to the whiteboard.
In Whiteboard mode, any drawings outside the current window frame are not
copied.

D  Other tools
Displays the tool panel.

E  Page up (Annotation mode only)
Scrolls up in the selected document.

F  Page down (Annotation mode only)
Scrolls down in the selected document.

G  Pen Settings
Displays the available pen type, thickness, or shape.

H  Black/Red/Blue/Green/Yellow/White
(Yellow/Green/Aqua/Pink/Red/Blue for highlighter pen)
Switches the color for the drawings.

I  Eraser
Switches to an eraser. Select the size of the eraser.

J  Add Text
Switches to text entry mode. Select the drawing area to display the text box.

K  Select
Selects drawn content or an inserted image so you can perform operations such as
moving the item or adjusting its size.
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L  Undo
Undoes the previous operation

M  Redo
Cancels an undo operation and restores the previous status.

N  Clear screen
Clears all drawing from the displayed page.

O  Exit
Exits the Easy Interactive Tools software.

g Related Links
• "Tool Panel Functions" p.32
• "Camera Screen" p.33
• "Settings Screen" p.34

Tool Panel Functions

When you select  from the toolbar, the tool panel is displayed.
Whiteboard mode

Annotation mode/Mouse mode

The display format of the tool panel is optimized for the mode you are
using.

A  New (Whiteboard mode only)
Creates a new file.

B  Open (Whiteboard mode only)
Opens previously saved files.

C  Export...
Saves the displayed screen in .pdf, .eit or .iwb format and all pages are saved as
one file. You can open the saved file in Whiteboard mode.

D  Print
Prints the current screen. In Whiteboard mode, all pages are printed. You can also
select the pages you want to print on the print settings screen.

E  Settings
Opens the Settings screen.
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F  Recent Files (Whiteboard mode only)
Displays the recently saved files list.

G  Keyboard
Displays a displayed keyboard you can use to enter characters.

H  Paste (Whiteboard mode only)
Pastes the content from the clipboard.

I  Shade
Covers the display with a shade. Drag the edge of the shaded area to size it. Click

 to delete the shade.

J  Spotlight
Emphasizes a portion of the display using a spotlight effect. Drag the spotlight

edge to select the area of emphasis. Click  to delete the spotlight.
You can change the shape of the spotlight on the General tab on the Settings
screen.

K  Camera
Displays the image from an Epson document camera connected to the computer.

L  Enlarge Area
Displays an enlarged view of the image. Drag the cursor over the area you want to
enlarge.

M  Help (Mouse operations only)
Displays help information.

Camera Screen

When you select  >  from the toolbar, the Camera screen is displayed.

The Camera screen lets you display images from a connected Epson document
camera. You can adjust the images as necessary and save them as an image or
movie file, depending on the document camera model.

A Select the document camera from which you want to project from the displayed
list.

B Rotates the image 180°.
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C Enlarges or reduces the image as follows:

• : Lets you drag the cursor to enlarge a selected image area in a new window.
(You cannot record or save the enlarged image.)

• : Enlarges the image.

• : Reduces the image.

D Displays the image at its actual size.

E Switches between full screen and window display.

F Automatically focuses the image.

G Freezes the image temporarily.

H Records the image and saves it in .avi format in Windows or .mov format on a
Mac. Select the save location on the Camera tab on the Settings screen.

• : Records document camera images and audio (except for drawings).
Displays the recording time in the lower right corner of the image. If audio
is not recorded, set the audio input device settings on the Camera tab on the
Settings screen.

• : Records document camera images at one second intervals (except for
drawings). No audio is recorded.

• : Stops recording.

I Saves the currently displayed image and drawings as a still image.

J Pastes the currently displayed document camera image onto a page in
Whiteboard mode.

K Displays the Picture Quality window. (Not available if the document camera does
not provide adjustments for brightness, contrast, or white balance.)

• : Adjusts image contrast using a slider.

• : Adjusts image brightness using a slider.

• : Adjusts image white balance (tint). To increase blue tint, move the slider
right. To increase red tint, move the slider left. (If you selected Auto White
Balance, the tint is adjusted automatically.)

• Reset: Restores the brightness, contrast, and white balance settings to their
default settings.

L Lets you pan and tilt an enlarged image by dragging and dropping it.

M Opens the toolbar so you can draw on the image.

g Related Links
• "Camera Tab" p.40

Settings Screen

To display the Settings screen, select  >  on the toolbar.
Select the tabs on the Settings screen to view and select all available settings.

g Related Links
• "General Tab" p.35
• "Enlarge Screen Tab" p.36
• "Language Tab (Windows Only)" p.38
• "Save Tab" p.39
• "Camera Tab" p.40
• "Whiteboard Mode Tab" p.42
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General Tab

Select general settings on the General tab on the Settings screen.
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Setting Options/Description

Toolbars sizes Select the toolbar size.

Toolbar orientation Select the toolbar orientation.

Spotlight shape Select the spotlight shape.

Slideshow Drawing
Tool

Select to use the dedicated slideshow toolbar when
projecting PowerPoint slides.

Right Click Settings Select the operation performed when you right-click in the
drawing area.
• Open Quick Toolbar: Opens the mini toolbox.
• Change to Mouse Mode: Switches from drawing to

mouse operations in Annotation mode.
• Change Between Pen and Eraser: Switches between

drawing and erasing functions.
• Clear screen: Clears all drawings from the screen.
• Off: Performs no operations when you right-click.

Auto Clear Screen Select screen clearing options. Clear screen erases all
drawn content when you switch to mouse operations in
Annotation mode, or select page up or page down.

Launch Mode Select the launch mode.
When you perform Restore defaults, the launch mode is set
to Whiteboard.

Usage Survey Select to allow Epson to acquire application usage
information. See the Privacy Statement for more details.

Version information Displays the version information for the Easy Interactive
Tools software.

g Related Links
• "Toolbar Functions" p.31
• "Using the Slideshow Drawing Tools" p.27
• "Turning a Spotlight on an Area" p.22

Enlarge Screen Tab

Select which screens you can draw on using the Enlarge Screen tab on the
Settings screen.
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Select one of the following as the Use Screen Settings option:
• Primary Display: Lets you draw only on the primary display.
• Secondary Display: Lets you draw only on the secondary display.
• Use Multi-Projection: Lets you draw across primary and secondary displays.
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Language Tab (Windows Only)

Select the language used for the Easy Interactive Tools software on the Language
tab on the Settings screen.
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Save Tab

Select file save settings for each Easy Interactive Tools software mode on the
Save tab on the Settings screen.
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Setting Options/Description

Check when saving Select to display a screen that lets you select the save
location, file name, and file format when saving images.

Save location folder Lets you select a folder for saving screens.
If you do not select a folder, these default folders are used:
• Windows:

<startup_drive>:\users\<user_name>\Documents\Easy
Interactive Tools

• Mac:
<startup_drive>:\Users\<user_name>\Documents\Easy
Interactive Tools

File name Lets you enter a file name up to 32 characters long for
the saved files. Each file is numbered automatically, such as
AAA0001.jpg.
Do not use these characters in your file name: \/:?"<>!

File type Lets you select the file format for saved files.

Camera Tab

Select recording and file save settings for document camera projection on the
Camera tab on the Settings screen.
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Setting Options/Description

Check when saving Select to display a screen that lets you select the save
location, file name, and file format when saving movies
images.

Save location folder Lets you select a folder for saving movies or images.
If you do not select a folder, these default folders are used:
• Windows:

<startup_drive>:\users\<user_name>\Documents\Easy
Interactive Tools

• Mac:
<startup_drive>:\Users\<user_name>\Documents\Easy
Interactive Tools

File name Lets you enter a file name up to 32 characters long for
the saved files. Each file is numbered automatically, such as
AAA0001.avi.
Do not use these characters in your file name: \/:?"<>!

File type Lets you select the file format for saved files.

No Audio Select to turn off recording of audio for movies.

Select Audio Device
automatically.

Select to automatically select the audio device when
recording movies.

Audio Device Select the audio device you want to use when recording
movies. (Unavailable if Select Audio Device automatically
is selected.)

Aspect Ratio Select the aspect ratio of the camera screen.
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Whiteboard Mode Tab

Select the display position of the Whiteboard page list on the Whiteboard mode
tab on the Settings screen.
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You can perform the following functions using the Whiteboard tools.

A •  New page
Adds a new page after the currently displayed page.

•  Copy page
Duplicates the current page and adds it after the current page.

•  Delete page
Deletes the current page.

B Insert image
Lets you select a .jpg, .bmp, or .png image file to insert into the currently
displayed page.

C Select background
Lets you select one of the following as a background image:
• One of 6 provided patterns of 3 colors
• A still image of the computer desktop
• An image file
• A document camera image

D  Page list
Displays the page list screen. Click the button again if you want to hide the page
list.

E  Previous page
Displays the previous page.

F  Next page
Displays the next page.

G  Window Display
Switches the drawing screen between full display and window display.
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Solving Problems

See the following section to check for solutions to problems you may have using the Easy Interactive Tools software.

g Related Links
• "Solving Problems with the Easy Interactive Tools Software" p.45



If you have any problems while using the Easy Interactive Tools software, check
for solutions here.

Problem Solution

Characters appear garbled
after changing the language.

Fonts for the selected language are not available in
your operating system. Select Restore defaults on
the Settings screen to return to the default settings.

When two people use
interactive pens, one of the
pens does not operate.

You are performing one of the following tasks that
allow only one interactive pen to be used:
• Operations on the Settings screen, Camera screen,

Insert image screen, Select background screen,
Open file screen, Save file screen, Export screen,
and Print screen

• Adjusting and editing identical shapes and images
• Entering text
• Operations on a window displayed in Whiteboard

mode
• You are using menus.

You cannot draw on a Keynote
slide presentation using a Mac.

You cannot draw on Keynote slides on a Mac.

Images do not display
correctly in the Enlarge area.

Make sure you are not displaying images from a
DVD player.

You cannot save or print
images from Windows Media
Player.

You are performing one of the following disallowed
operations:
• You are using an application that requires the

Microsoft DirectX function.
• You are displaying images from a DVD player.

Problem Solution

When opening a .eit, .iwb, .ewf
or .ewf2 file, some of the
drawings appear incorrectly.

One of the following has occurred:
• You have opened the file in Annotation mode

on a computer with a different display resolution
than the computer that originally saved the file.
Match the file's display resolution for best results.

• Some object types for .iwb/.ewf/.ewf2 file are not
supported in the Easy Interactive Tools software.
Open the file in the original environment or
create the drawing and file again in the Easy
Interactive Tools software.

• The file may have been corrupted. Create the
drawing and file again.

You cannot playback recorded
movies correctly.

For best results, use Windows Media Player to play
movies recorded using a document camera.
If you do not hear audio, one of the following has
occurred:
• The movie may have been recorded from an

incompatible document camera.
• The audio is .mp3 file format that is not

supported.

Drawings across two screens
are cut off.

Make sure you installed the Easy Interactive
Driver Ver.4.0. (The installation environment of the
projectors may also cause drawings to be cut off, so
check the installation of your projectors.)

You cannot operate the camera
on a Mac.

On the Mac, select System Preferences > Security
& Privacy > Privacy and make sure that the Easy
Interactive Tools software is allowed to access the
application that you cannot operate.You cannot operate the

PowerPoint drawing toolbar
using a Mac.

g Related Links
• "Settings Screen" p.34
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Appendix

See these sections to learn more about the Easy Interactive Tools software.

g Related Links
• "Updating and Uninstalling the Software" p.47
• "Notices" p.48



Follow these instructions to update or uninstall the Easy Interactive Tools
software.

g Related Links
• "Getting the Latest Version of the Software" p.47
• "Uninstalling the Easy Interactive Tools Software (Windows 10/Windows 11)"

p.47
• "Uninstalling the Easy Interactive Tools Software (Mac)" p.47

Getting the Latest Version of the Software

Updates to this software and its guide may be available on the Epson Web site.
Visit epson.sn.

Uninstalling the Easy Interactive Tools Software
(Windows 10/Windows 11)

Follow the instructions below to uninstall the Easy Interactive Tools software.

You need administrator authority to uninstall the software.

a Turn on your computer.

b Make sure all running applications are closed.

c Press the  key on the keyboard to display all apps.

d Right-click (press and hold) Easy Interactive Tools Ver.X.XX, and then
select Uninstall.

e Follow the on-screen instructions.

Uninstalling the Easy Interactive Tools Software (Mac)

For Mac, follow the instructions below to uninstall the Easy Interactive Tools
software.

a Turn on your computer.

b Make sure all running applications are closed.

c Open the Applications folder.

d Open the Easy Interactive Tools Ver. X.XX - Tools folder, and then
double-click Easy Interactive Tools Uninstaller.

e Follow the on-screen instructions.
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Check these sections for important notices about your software.

g Related Links
• "Copyright Notice" p.48
• "About Notations" p.48
• "General Notice" p.48
• "Open Source Software License" p.49
• "Copyright Attribution" p.49

Copyright Notice

All rights reserved. No part of this publication may be reproduced, stored in
a retrieval system, or transmitted in any form or by any means, electronic,
mechanical, photocopying, recording, or otherwise, without the prior written
permission of Seiko Epson Corporation. No patent liability is assumed with
respect to the use of the information contained herein. Neither is any liability
assumed for damages resulting from the use of the information contained
herein.
Neither Seiko Epson Corporation nor its affiliates shall be liable to the purchaser
of this product or third parties for damages, losses, costs, or expenses incurred
by the purchaser or third parties as a result of: accident, misuse, or abuse of this
product or unauthorized modifications, repairs, or alterations to this product,
or (excluding the U.S.) failure to strictly comply with Seiko Epson Corporation's
operating and maintenance instructions.
Seiko Epson Corporation shall not be liable against any damages or problems
arising from the use of any options or any consumable products other than
those designated as Original Epson Products or Epson Approved Products by
Seiko Epson Corporation.
The contents of this guide may be changed or updated without further notice.
Illustrations in this guide and the actual projector may differ.

About Notations

• Microsoft ® Windows® 10 operating system
• Microsoft ® Windows® 11 operating system
In this guide, the operating systems above are referred to as "Windows 10" and
"Windows 11". Furthermore, the collective term "Windows" is used to refer to
them all.

• macOS 13 (Ventura)

• macOS 14 (Sonoma)

• macOS 15 (Sequoia)

• macOS 26 (Tahoe)

In this guide, the collective term "Mac" is used to refer to all of the operating 
systems above.

General Notice

Keynote, Mac, OS X and macOS are trademarks of Apple Inc.

Microsoft, DirectX, PowerPoint, and Windows are trademarks or registered
trademarks of Microsoft Corporation in the United States and/or other
countries.
Other product names used herein are also for identification purposes only and
may be trademarks of their respective owners. Epson disclaims any and all
rights in those marks.
Software Copyright: This product uses free software as well as software to which
this company holds the rights.
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Open Source Software License

zlib
This projector product includes the open source software program "zlib" which
applies the terms and conditions provided by owner of the copyright to the
"zlib".
The "zlib" are WITHOUT ANY WARRANTY; without even the implied
warranty of MERCHANTABILITY AND FITNESS FOR A PARTICULAR
PURPOSE.
List of zlib programs
• zlib-1.2.8
License terms of conditions of each program which are provided by owner of
the copyright to the "zlib" are as follows.
Copyright notice:
(C) 1995-1998 Jean-loup Gailly and Mark Adler
This software is provided 'as-is', without any express or implied warranty. In no
event will the authors be held liable for any damages arising from the use of this
software.
Permission is granted to anyone to use this software for any purpose, including
commercial applications, and to alter it and redistribute it freely, subject to the
following restrictions:
1. The origin of this software must not be misrepresented; you must not claim
that you wrote the original software. If you use this software in a product, an
acknowledgment in the product documentation would be appreciated but is not
required.
2. Altered source versions must be plainly marked as such, and must not be
misrepresented as being the original software.
3. This notice may not be removed or altered from any source distribution.
Jean-loup Gailly
jloup@gzip.org
Mark Adler

madler@alumni.caltech.edu
If you use the zlib library in a product, we would appreciate *not* receiving
lengthy legal documents to sign. The sources are provided for free but without
warranty of any kind. The library has been entirely written by Jean-loup Gailly
and Mark Adler; it does not include third-party code.
If you redistribute modified sources, we would appreciate that you include in
the file ChangeLog history information documenting your changes.

Copyright Attribution

This information is subject to change without notice. 
© 2024 Seiko Epson Corporation
2025.10 Ver.5.22 EN
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